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NEW QUESTION 1

Refer to the exhibit. In an active SIP call between phone user A and phone user B, phone A initiates a call transfer to phone user C. Which two scenarios are
correct? (Choose two.)

A. Phone_A sends a SIP-REFER message to the Cisco Unified Communications Manager with Phone_C information in the Refer-To section.
B. Phone_B sends a SIP-REFER message to the Cisco Unified CM with Phone_C information in the Refer-To section.
C. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_B User Hold MOH
Audio Source settings.
D. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the music on hold and the MOH audio is chosen from Phone_A Network
Hold MOH Audio Source settings.
E. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_A User Hold MOH
Audio Source settings.

Answer: AC

NEW QUESTION 2
Which two extended capabilities must be configured on dial peers for fast start-to-early media scenarios (H.323 to SIP interworking)? (Choose two.)

A. DTMF
B. BFCP
C. VIDEO
D. FAX
E. AUDIO

Answer: AB

NEW QUESTION 3
An administrator is troubleshooting call failures on an H.323 gateway via the CLI. To see signaling for media and call setup, which debug must the Administrator
turn on?

A. debug H.323 messages
B. debug H.225 asn1
C. debug H.246 asn 1
D. debug H.225 media
E. debug H.323 asn 1

Answer: B

NEW QUESTION 4
Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?

A. Analysis Manager > Inventory > Trace File Repositories
B. System > Tools > Trace and Log Central
C. Voice/Video > Session Trace Log View > Real Time Data
D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 5
Which description of RTP timestamps or sequence numbers is true?

A. The sequence number is used to detect losses.
B. Timestamps increase by the time “carrying” by a packet.
C. Sequence numbers increase by four for each RTP packet transmitted.
D. The timestamp is used to place the incoming audio and video packets in the correct timing order (playout delay compensation).

Answer: D

NEW QUESTION 6
A company has an SRST gateway running an IOS XE image. The company plans to enable the IPv6 addressing companywide. To enable the IPv6 in a unified
SRST gateway to support SIP phones, what are two supported supplementary features for an IPv6 fallback scenario? (Choose two.)

A. three-way conference
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B. secure SIP lines
C. T.38 fax relay
D. transcoding
E. SIP trunk

Answer: AC

NEW QUESTION 7
Which action is correct with respect to toll fraud prevention configuration in the Cisco Unified Communications Manager Express?

A. Configure Direct Inward Dial for Incoming ISDN Calls with overlap dialing.
B. Configure IP Address Trusted Authentication for Incoming VoIP Calls.
C. Configure the command no ip address trusted authenticate under “voice service voip”.
D. Enable Secondary Dial tone on Analog and Digital FXO Ports.

Answer: B

NEW QUESTION 8
You see the voice register pool 1 command in your Cisco Unified Communications Manager Express configuration. Which configuration is occurring in this
section?

A. configuration for a single SIP phone
B. configuration items common for all SIP phones
C. configuration for a pool of SIP phones (similar to device pool on Cisco Unified Communications Manager)
D. configuration for SIP registrar service

Answer: C

NEW QUESTION 9
For s SIP to SIP call flow, when does Cisco Unified Border Element require transcoding resources for DTMF?

A. interworking between an OOB method and RFC2833 for flow-around calls
B. interworking between h245-signal and rtp-nte
C. interworking between an OOB method and RFC2833 for flow-through calls
D. interworking between h245-alpha numeric and sip-kpml

Answer: A

NEW QUESTION 10
Where is the dtmf-relay command configured on Cisco Unified Border Element?

A. in the voice-class VoIP configuration
B. in the VoIP dial peer
C. in global SIP configuration
D. in the VoIP or POTS dial peers

Answer: B

NEW QUESTION 10

Refer to the exhibit. Calls incoming from the provider are not working through newly set up Cisco Unified Border Element. Provider engineers get the 404 Not
Found SIP message. Incoming calls are coming from the provider with called number “222333444” and Cisco Unified Communications Manager is expecting the
called number to be delivered as “444333222”. The administrator already verified that the IP address of the Cisco Unified CM is set up correctly and there are no
dial peers configured other than those shown in the exhibit. Which action must the administrator take to fix the issue?

A. Change the destination-pattern on the outgoing dial peer to match “444333222”.
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B. Set up translation-profile on the incoming dial peer to match incoming traffic.
C. Create specific matching for “222333444” on the incoming dial peer.
D. Fix the voice translation-rule to match specifically number “222333444” and change it to “444333222”.

Answer: B

NEW QUESTION 15
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

A. example.com@gateway.corporate.local
B. *@example.com
C. gateway.corporate.local
D. example.com
E. *.*

Answer: BE

NEW QUESTION 19
An engineer must configure a secure SIP trunk with a remote provider, with a specific requirement to use port 5065 for inbound and otubound traffic. Which two
items must be configured to complete this configuration? (Choose two.)

A. Incoming Port in SIP Information section of the SIP Trunk configuration.
B. Incoming Port in Security Information of the SIP Profile configuration.
C. Destination Port in SIP Information section of the SIP Trunk configuration
D. Incoming Port in SIP Trunk Security Profile configuration
E. Destination Port in SIP Trunk Security Profile configuration

Answer: CD

NEW QUESTION 24
If all patterns below are configured in Cisco Unified Communications Manager which would be used when dialing the pattern “123”?

A. 12!
B. 12X (urgent priority set)
C. 1XX (urgent Priority Set)
D. 12[2-5]

Answer: B

NEW QUESTION 29

Refer to the exhibit. Users report that when they dial the emergency number 9911 from any internal phone, it takes a long time to connect with the emergency
operator. Which action resolves this issue?

A. Adjust the service parameter T302 timet to the desired value.
B. Adjust the service parameter T204 timer to the desired value.
C. Check the Urgent Priority check box under 9.911 pattern.
D. Point the emergency pattern directly to the PSTN gateway.

Answer: C

NEW QUESTION 30
The Cisco Unified Communications Manager Dialed Number Analyzer allows analysis of calls from which two devices? (Choose two.)

A. translation patterns
B. device pools
C. CTI ports
D. CTI route points
E. IP phones

Answer: CE

NEW QUESTION 32
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Refer to the exhibit. An administrator is troubleshooting a situation where a call placed from a phone registered to Cisco Unified Communications Manager does
not complete. The administrator wants to use the Dialed Number Analyzer on Cisco Unified CM to check which translation pattern the call is matching. However,
when logging in to Cisco Unified Serviceability there is no option for Dialed Number Analyzer under the tool menu. Which two steps must be performed to resolve
this issue? (Choose two.)

A. Restart the subscriber
B. Activate the Cisco Extended Functions service.
C. Activate the Cisco CallManager service.
D. Activate the Cisco Dialed Number Analyzer service.
E. Activate the Cisco Dialed Number Analyzer Server service.

Answer: DE

NEW QUESTION 34
In Cisco Unified Communications Manager globalized call routing is implemented and must confirm that it is correctly implemented without making a call. Which
tool do you use for verification?

A. Dialed Number Analyzer
B. Real-Time Monitoring Tool
C. SDI trace
D. SDL trace

Answer: A

NEW QUESTION 37
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Refer to the exhibit. Within the North American Numbering Plan, gateways located in Ottawa, Canada and marked as “YOW” are assigned to the Calling Party
Transformation CSS NANP_CgPTP, which contains partition NANP_calling_xforms. What is the calling-party number and the numbering type if the calling user
+1613-555-1234 dials the number?

A. calling number 613-555-1234 and numbering type “subscriber”
B. calling number 011-1-613-555-1234 and numbering type “subscriber”
C. calling number 011613-555-1234 and numbering type “international”
D. calling number 613-555-1234 and numbering type “national”

Answer: D

NEW QUESTION 39
Where on Cisco Unified Communications Manager do you configure the standard local route group for a group of devices?

A. System > Location Info
B. Call Routing > Route/Hunt > Local Route Group Names
C. System > Device Pool
D. Call Routing > Emergency Location > Emergency Location (ELIN) Groups

Answer: B

NEW QUESTION 41
Which call pickup feature allows users to pick up incoming calls in a group that is associated with their own group?

A. Other Group Pickup
B. BLF Call Pickup
C. Group Call Pickup
D. Directed Call Pickup

Answer: A

NEW QUESTION 45
When locations-based Call Admission Control denies the call, which two masks can AAR apply when routing the call through the PSTN? (Choose two.)

A. AAR destination mask
B. called party transform mask
C. external phone number mask
D. +E.164 alternate number mask
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E. enterrise alternate number mask

Answer: AC

NEW QUESTION 50
When configuring hunt groups, where do you add the individual directory numbers that will be part of the group?

A. route group
B. line group
C. hunt list
D. hunt pilot

Answer: B

NEW QUESTION 52
Which configuration element of a hunt group allows for changing Calling Party Transformations settings?

A. line group
B. hunt pilot
C. route group
D. hunt list

Answer: B

NEW QUESTION 57
What is the relationship between partition, time schedule, and time period in Time-of-Day routing in Cisco Unified Communications Manager?

A. A partition can have multiple time schedules assigne
B. A time schedule contains one or more time periods.
C. A partition can have one time schedule assigne
D. A time schedule contains one or more time periods.
E. A partition can have multiple time schedules assigne
F. A time schedule contains only one time period.
G. A partition can have one time schedule assigne
H. A time schedule contains only one time period.

Answer: A

NEW QUESTION 60
A user reports that when they attempt to log out from the Cisco Extension Mobility service by pressing the Services button, they cannot log out. What is the most
likely cause of this issue?

A. The Cisco Extension Mobility service has not been configured on the phone.
B. There might be a significant delay between the button being pressed and the Cisco Extension Mobility service recognizing i
C. It would be best to check network latency.
D. The user device profile has not been assigned to the user.
E. The user device profile is not subscribed to the Cisco Extension Mobility service.

Answer: D

NEW QUESTION 61
When the services key is pressed Cisco Extension Mobility does not show up. What is the cause of the issue?

A. The URL configured for Cisco Extension Mobility is not correct.
B. Cisco Extension Mobility Service is not running.
C. The phone is not subscribed to Cisco Extension Mobility Service.
D. Cisco Extension Mobility is not enabled in the Phone Configuration Window (Device > Phone)

Answer: C

NEW QUESTION 66
......

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM 300-815 Dumps From Exambible
https://www.exambible.com/300-815-exam/ (118 Q&As)

Relate Links

100% Pass Your 300-815 Exam with Exambible Prep Materials

https://www.exambible.com/300-815-exam/

  

Contact us

We are proud of our high-quality customer service, which serves you around the clock 24/7.

Viste - https://www.exambible.com/

Powered by TCPDF (www.tcpdf.org)

Your Partner of IT Exam visit - https://www.exambible.com 

https://www.exambible.com/300-815-exam/
https://www.exambible.com/
http://www.tcpdf.org

